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Legal Disclaimer
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[bookmark: _Toc516648434][bookmark: _Toc11147450][bookmark: _Toc109306754]Release Notes
This document contains shared release notes and planned changes. Shared release notes and planned changes document features and changes that apply to SAP Concur solutions site-wide or to multiple SAP Concur products and services. They include but are not limited to:
· Security-related features and changes such as annual security certificate renewals and changes in support for security ciphers and protocols
· Site-wide UI features and changes such as changes to the home page, changes to the site header or footer, or the implementation of new site-wide UI themes
· Sign-in process features and changes such as the addition or removal of sign-in features, URL changes, and domain name changes
· Production and test environment features and changes
· Global settings or administration page features and changes such as the addition of new site-wide settings or changes to the design of the administration pages
· Changes to processes such as where and when release notes are published
For New Features and Changes that apply to a single product and/or service see the release notes for that product or service. Links to the product and service-specific release notes can be found on the following pages:
Professional Edition
Standard Edition
Small Business Edition

[bookmark: _Toc109306755]File Transfer Updates
[bookmark: _Toc93580783][bookmark: _Toc109306756]**Ongoing** Rotating PGP Key for File Transfers

	[bookmark: _Hlk92987153]Information First Published
	Information Last Modified
	Feature Target Release Date

	February 2021
	June 10, 2022
	January 15, 2021 and October 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93580784][bookmark: _Toc109306757]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
Files transferred to SAP Concur products must be encrypted with the SAP Concur public PGP key, concursolutionsrotate.asc. 
IMPORTANT!

Upcoming PGP key changes:

• The legacy (non-rotating) key, key ID D4D727C0, will be deprecated on October 11, 2022.

• The current rotating key, key ID 40AC5D35, will expire on September 4, 2022. 

• A new rotating key, key ID 9AFF10B5, is available in the client's root folder.
New rotating PGP key details:
· Key ID: 9AFF10B5
· Filename: concursolutionsrotate.asc
The filename for the rotating PGP key does not change when the key is rotated.
· As of June 4, 2022, the new rotating public PGP key is available in the client’s root folder. 
· RSA 4096-bit signing and encryption subkey.
· This key expires on September 4, 2024.
· Clients are responsible for replacing the rotating key before it expires.
· A new key will be provided 90 days before the September 4, 2024 expiration date.
Expiring rotating PGP key details:
· Key ID: 40AC5D35
· Filename: concursolutionsrotate.asc
· This key will expire on September 4, 2022.
Legacy (non-rotating) PGP key details:
· Key ID: D4D727C0
· The SAP Concur legacy (non-rotating) PGP key will be deprecated on October 11, 2022. 
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
· AWS transfer endpoints (when they are communicated to you)
Business Purpose / Client Benefit
The rotating public PGP key provides greater security for file transfers.
Admin Experience
An administrator with the required file transfer credentials can log into the file transfer site to retrieve the rotating public PGP key, concursolutionsrotate.asc, from the root directory.
Configuration / Feature Activation
Your internal file transfer administrator can add the new rotating key to their PGP keyring and start using it to encrypt files being transferred to SAP Concur any time prior to September 4, 2022. 
If you require assistance, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc109306758]Financial Integration
[bookmark: _Toc109306759]Drop Down Menus Added to Fringe Benefit Account and Reclaim Code Columns (Xero Accounting)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	July 8, 2022
	--
	July 16, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306760]Expense, Invoice | Standard
Overview
Drop down menus have been added to the Account Code and Reclaim Code columns on the Fringe Benefits page in Product Settings > VAT for Xero Accounting.
Business Purpose / Client Benefit
The dropdown menus enable the administrator to assign the correct Account Code and Reclaim Code to an expense based on the attendee to whom the expense is assigned.
Admin Experience
When the admin navigates to Product Settings > VAT > Fringe Benefits and then click on an Account Code or Reclaim Code field in the Account Code or Reclaim Code column, a dropdown list is available.
[image: ]
Configuration / Feature Activation
This change occurs automatically.
[bookmark: _Toc109306761]Post to Top-Level Entity for Sage Intacct

	Information First Published
	Information Last Modified
	Feature Target Release Date

	July 8, 2022
	--
	July 16, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306762]Expense, Invoice | Standard Edition
Overview
An option to post only to the top-level Sage Intacct child entity has been added to the ERP Authentication. In addition, if this option is selected when connecting to Sage Intacct, the Accounting page displays the following message:
"You are using the Top Level child entity."
Business Purpose / Client Benefit
With this change, clients with more than ten entities will no longer have to reduce the number of entities to ten or fewer before connecting to Sage Intacct.
Admin Experience
When an admin navigates to the Accounting page in Product Settings and then clicks the Sage Intacct button to connect to their ERP, the Use only Top Level child entity option is available on the ERP Authentication page.
[image: ]
After selecting the Use only Top Level child entity option, when they navigate to the Accounting page in Product Settings, they see the following message:
"You are using the Top Level child entity."
[image: ]
Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc109306763]Sage Accounting To Be Retired

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 15, 2022
	July 8, 2022
	July 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306764]Expense, Invoice | Standard Edition
Overview
In July 2022, SAP Concur solutions plans to retire the Sage Accounting integration with Concur Expense and Concur Invoice.
This change does not impact the Sage Intacct integration.
Business Purpose / Client Benefit
This integration offering has not been adopted by any SAP Concur clients.
Configuration / Feature Activation
This retirement will occur automatically.
[bookmark: _Toc109306765]Help Menu
[bookmark: _Hlk96071113][bookmark: _Toc109306766]**Ongoing** Consolidation of Resources Under Help Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	July 8, 2022
	July 6, 2022 and Future release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306767]All Products | All Editions
Overview
On July 6, SAP began consolidating SAP Concur help resources under the Help menu in SAP Concur solutions. The changes will occur in two phases:
· Phase 1 -July 6, 2022: The Help menu was updated. Updates include changes to the overall appearance and organization of the menu. In addition, for clients with SAP Enable Now content, users can access SAP Enable Now content from the Help menu.
For more information about support for SAP Enable Now, refer to the Support for SAP Enable Now release note in this document.
· Phase 2 – Targeted for a future release: 
User assistance for admins and end users (OEM WalkMe), video tutorials, and tools for contacting support will be accessed from the consolidated Help menu.
The Get Assistance icon (?) that is currently used to access those items will be removed from the UI.
On SAP Concur Standard edition, if user assistance is enabled and a client is in the implementation phase or trying the free trial version, a new chat icon will be available.
For more information about user assistance for admins and end users, refer to the User Assistance for Admins and End Users fact sheet.
Business Purpose / Client Benefit
These changes improve ease of use and simplify the SAP Concur user interface by providing a single point of access to help resources.
End-User Experience
As of July 6, 2022, when an admin or end user clicks Help, they see the redesigned Help menu, and, if SAP Enable Now content is available to them, they will see the Explore Interactive Content item in the menu.
Previous Menu Example
[image: ]
Current Menu Example
[image: ]
The list of items in the Help menu depends on a user's roles and permissions and on the configuration of the client's site. For example, only users with administrator privileges have access to Administrative Resources.
When all of the changes have been implemented, new options will be available in the Help menu—for example, if User Assistance for End Users is enabled, a link to access those resources will appear in the Help menu. In addition, the Get Assistance icons that currently provide access to those features will be removed from the user interface.
Current Get Assistance Icons
[image: ] [image: ]
In addition, on SAP Concur Standard edition entities that are in the implementation phase or are a free trial instance, a chat icon will be available on pages in the UI.
Future Chat Icon
[image: ] [image: ]
Configuration / Feature Activation
These changes will be implemented automatically.
[bookmark: _Toc109306768]Home Page
[bookmark: _Toc109306769]**Ongoing ** SAP Concur Homepage Changes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 4, 2020
	May 13, 2022
	Q4 2021 – Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306770]All Products | All Editions
Overview
[bookmark: _Hlk19876476][bookmark: _Hlk19876428]In Q4, 2021, SAP Concur began redirecting clients to a new homepage. The appearance of the new homepage is identical to the previous SAP Concur homepage. The new homepage has enhanced functionality when services become temporarily unavailable.
The roll out of the new homepage is phased:
Phase 1: In October of 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the US Datacenter to the new homepage. 
Phase 2: In December 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the EU Datacenter to the new homepage.
Phase 3: At a date to be determined, SAP Concur will begin redirecting the remaining clients in the US and EU datacenters to the new homepage. The remaining clients include those with Concur Travel standalone or Concur Travel with Expense, Invoice, and/or Request.
Business Purpose / Client Benefit
This change ensures that the SAP Concur homepage is available even when some services are unavailable and improves the consistency of the sign in experience.
End-User Experience
With the old homepage, when a user signs into their SAP Concur products, they see their homepage.
The appearance of the homepage varies depending on which products and services are enabled for the client and the permissions assigned to the user.

If some products or services are unavailable while other products and services are up and running, a modified version of the user’s homepage similar to the following appears: 
[image: ]
After a client is migrated to the new homepage, if one or more services are unavailable, when a user signs in to their SAP Concur products, they will see the usual homepage, but if the user navigates to a page for a service that is unavailable, they will see a page similar to the following:
[image: ]
After migration to the new homepage, if all services are available, this change is transparent to the user and they see a homepage that is identical to the pre-migration homepage.
Example Homepage

Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc109306771]Miscellaneous
[bookmark: _Toc109306772]**Ongoing** SAP Concur Migration to Cloud Platform in AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	March 18, 2022
	Ongoing in 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306773]All Products | All Editions
Overview
SAP Concur plans to migrate from a pure private cloud operation, where all equipment is owned by SAP Concur, to a cloud platform. We plan to close our own private data centers in favor of a cloud platform implemented in Amazon Web Services (AWS). While this process started in 2017, we are focused on the final phase of the migration in 2022 for the North American and EMEA data centers.
Business Purpose / Client Benefit
This change provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
End-User Experience During Migration
While a company is being migrated from an SAP Concur private data center to the cloud platform, their SAP Concur solutions might not be available to end users. 
If an end user tries to sign in to SAP Concur solutions during the migration process, they might not be able to sign in and they might receive the following message:
"SAP Concur solutions is undergoing scheduled maintenance. Please try again later"
[image: ]
If an end user is working in SAP Concur solutions when their company is migrated, they might be returned to the sign in page.
SAP plans to implement migrations on weekends and after business hours. 
Configuration / Feature Activation
This change will occur automatically.
For details, refer to the SAP Concur Cloud Platform Strategy FAQ.
[bookmark: _Toc109306774]Profile Settings
[bookmark: _Toc109306775]**Ongoing** Changes to My Profile, Home Page, and Profile Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	June 10, 2022
	Ongoing beginning in April 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306776]Travel, Expense, Invoice, Request, Mobile | Professional & Standard
Overview
SAP Concur has implemented or plans to implement changes to several pages in the UI. The changes will be implemented over time beginning in April of 2022 and continuing throughout 2022. 
These changes reflect SAP's commitment to supporting gender diversity by enabling gender non-binary users to enter consistent information when making travel arrangements and entering information in SAP Concur solutions. Changes include but are not limited to the following:
April 2022 Release
· The greeting on the SAP Concur Home page was removed. In addition, first and last name were removed from the menu in the SAP Concur mobile app.
· If a user adds their preferred name on the My Profile – Personal Information page in Profile Settings, their preferred name and last name is displayed in the SAP Concur Profile menu.
May 2022 Release
· The Nickname field on the My Profile – Personal Information page was changed from Nickname to Preferred Name.
· The Nickname field in the Employee Travel Addendum Import 350 file was changed from Nick Name to Preferred Name.
· The Nickname field in the Employee Import file was changed from Nickname to Preferred Name.
June 2022 Release
· The Nickname field on the user details page in User Administration was changed from Nickname to Preferred Name.
Future Releases
· A new option, Mx, will be added to the Title list on the My Profile – Personal Information page.
· New options will be added to enable users to select a non-binary gender in the TSA Secure Flight section of Travel Preferences.
· New options will be added to the gender field in the Travel Profile 2.0 API. This change will enable callers, such as TMCs and App Center partners, to provision (write) and receive (read) the new non-binary gender values.
Business Purpose / Client Benefit
These changes:
· Enable users to enter information into SAP Concur solutions that is consistent with their identity.
· Enable SAP Concur solutions to address a user by their preferred name.
· Ensure that information in SAP Concur solutions matches a user's government-issued identification.
· Ensure that travel documents such as airplane tickets purchased through SAP Concur solutions display information that is consistent with other required documents.
Implemented and Planned Changes
SAP Concur has implemented or plans to implement the following changes overtime beginning in April 2022 and continuing throughout 2022. 
April 2022 Release
Web UI Page Header
[bookmark: _Hlk100142441]The greeting on the Concur home page, "Hello <First Name>" was removed in April. The greeting included the name from the First Name field in the end user's user account.
Previously
The greeting "Hello, <First Name>" was included on the SAP Concur homepage.
[image: ]
With the April 2022 Release
The greeting is no longer included.
[image: ]
Mobile App
Previously
Prior to the April 2022 release, the menu in the Mobile app included the first and last names from the respective fields in the user's user account.
[image: ]
With the April 2022 Release
With the April 2022 release, no name is included at the top of the Mobile app menu.
[image: ]
Web UI Profile Menu
Beginning with the April release, if a user specifies a preferred name on the Profile – Personal Information page in Profile Settings, when they click on Profile in the web version of SAP Concur solutions, their preferred name and last name is displayed. 
[image: ]
If the user has not specified a preferred name, their first and last names from their user account information will be displayed.
May 2022 Release
My Profile - Personal Information – Preferred Name
Preferred Name Field
Prior to the May 2022 release, a Nickname field was included on the My Profile – Personal Information page. With the May 2022 release, this field will be replaced by the Preferred Name field.
[image: ]
Preferred Name in Import and Extract Files
With the May 2022 release, the Nickname fields in import and extract files will be renamed to Preferred name.
Employee Travel Addendum Import 350
The Preferred Name field will replace the Nick Name field in Employee Travel Addendum Import 350.
[image: ]
User Import
The Preferred Name field will replace the Nickname field in User Import.
[image: ]
Import Data
The Preferred Name field will replace the Nickname field in the user general information template.
[image: ]
Previously downloaded templates containing the Nickname field will continue to be processed.
June 2022 Release
On the user detail pages in User Administration, in the General Settings section, the Nickname field will be changed from Nickname to Preferred Name.
[image: ]
Future Releases
Title List
In a future release, a new gender non-binary option, Mx (pronounced "Mix"), will be added to the list in the Title list.
Travel Preferences TSA Secure Flight
Currently, users see two options under Gender in the TSA Secure Flight section of Travel Preferences. 
[image: ]
In a future release, users will have two additional options under Gender: undisclosed (x) and unspecified (u). 
When selecting a gender option, users should choose the option that matches the government-issued ID they use when travelling.
Web UI Profile Menu
When users with permission to act on behalf of another user—for example, Travel Arrangers and Delegates—search for and act as another user, they will see the preferred name of the user they are acting on behalf of in the search field and at the top of the Profile menu.
[image: ]   [image: ] 
Configuration / Feature Activation
These changes will occur automatically over time. Users might need to update the information on the My Profile – Personal Information page after the changes are implemented. 
For more information, refer to the Preferred Name and Nonbinary Gender Options fact sheet.
[bookmark: _Toc109306777]SAP Concur App Center
[bookmark: _Toc109306778]App Center Page Filter

	Information First Published
	Information Last Modified
	Feature Target Release Date

	July 8, 2022
	--
	July 15, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319752][bookmark: _Toc109306779]All Products | Professional & Standard
Overview
When a user goes to the App Center or clicks the App Center tab in SAP Concur, they can filter the apps that display based on criteria such as product configuration and region. If the user is logged into the app, the App Center automatically filters apps based on that user’s data, including their country of residence and company’s configured products. They can further refine the apps listing by selecting from the category and region dropdowns. The option to disable the filters and view all listed apps is also available.
Business Purpose / Client Benefit
Users can see the apps that are most relevant to their experience upon login or choose to filter app listings based on specific criteria.
End-User Experience
On the App Center web page, users will see dropdown lists above the apps that will allow them to control the list of apps that they see. 
In addition to Category, they can filter by product and edition, country, and region.
[image: ]
Configuration / Feature Activation
This feature is automatically enabled and no configuration is required.
For more information, refer to the Shared: App Center Administrator User Guide.
[bookmark: _Toc109306780]Security
[bookmark: _Toc109306781]Some TLSv1.2 Ciphers No Longer Supported 

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	July 8, 2022
	February 1, 2022 & Nov/Dec 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306782]Travel, Expense, Invoice, Request | All Editions
Overview
SAP Concur no longer supports connections to *.concursolutions.com and * api.concursolutions.com that use the following TLSv1.2 ciphers:
	[bookmark: _Hlk106881988]Akamai/OpenSSL cipher name
	IANA cipher name

	AES256-GCM-SHA384
	TLS_RSA_WITH_AES_256_GCM_SHA384

	AES128-GCM-SHA256
	TLS_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-AES128-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

	ECDHE-RSA-AES256-SHA
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

	ECDHE-RSA-AES128-SHA
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA


To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, clients and partners who connect to *.concursolutions.com and *api.concursolutions.com through an application that uses a retired cipher must update the application to a supported cipher.
Because some SAP Concur clients use an operating system that does not yet support any of the SAP Concur supported ciphers, removal of support for the following cipher has been postponed:
	Akamai/OpenSSL cipher name
	IANA cipher name

	ECDHE-RSA-AES256-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384


Business Purpose / Client Benefit
This update provides ongoing security for our products and services.
Confirming Supported Ciphers
The following ciphers included in the ak-akamai-2020q1 cipher profile are supported:

	Akamai/OpenSSL cipher name
	IANA cipher name

	TLS-AES-256-GCM-SHA384
	TLS_AES_256_GCM_SHA384

	TLS-CHACHA20-POLY1305-SHA256
	TLS_CHACHA20_POLY1305_SHA256

	TLS-AES-128-GCM-SHA256
	TLS_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-GCM-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

	ECDHE-RSA-AES128-GCM-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-CHACHA20-POLY1305
	TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_SHA256


If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
You can confirm that your cipher suite includes a supported cipher by cross-referencing the Akamai/OpenSSL cipher name with the IANA cipher name in the ak-akamai-2021 (default) column in the following table. 
Supported ciphers are indicated with a check mark.
[image: ] 
Testing Ciphers
The following procedure is intended for use by system administrators who want to test whether their cipher suite configuration will work correctly when connecting to SAP Concur solutions after support for the ciphers listed above has been removed. 
This procedure configures the system admin's local machine to connect to an akamai staging environment where support for the listed ciphers has already been removed. 
Summary of the procedure:
· Retrieve the IP address of the akamai production environment.
· Retrieve the IP address of the akamai staging environment.
· Redirect navigation to concursolutions.com to the akamai staging environment by editing the local Hosts file.
· Test a connection to concursolutions.com.
Confirm Your Cipher Suite is Working Correctly
Retrieve the IP Address of the Akamai Production Environment
1. Ping www.concursolutions.com
Windows: Open a Command Prompt window, type “Ping www.concursolutions.com” and then press Enter.
Mac: Open Terminal, type “Ping www.concursolutions.com” and then press Enter.
Example response
Pinging e7868.b.akamaiedge.net (23.46.104.197): 56 data bytes
64 bytes from 23.46.104.197: icmp_seq=0 ttl=50 time=125.070 ms
64 bytes from 23.46.104.197: icmp_seq=1 ttl=50 time=111.866 ms
64 bytes from 23.46.104.197: icmp_seq=2 ttl=50 time=111.967 ms
64 bytes from 23.46.104.197: icmp_seq=3 ttl=50 time=112.435 ms
Copy the highlighted address in the response.
Example address
e7868.b.akamaiedge.net
Retrieve the IP address of the akamai staging environment
1. In the Command Prompt or Terminal window, ping the copied address, but with “-staging” appended to “akamaiedge”.
Example Ping command
Ping e7868.b.akamaiedge-staging.net
Example response
Pinging e7868.b.akamaiedge-staging.net (104.76.225.252): 56 data bytes
64 bytes from 104.76.225.252: icmp_seq=0 ttl=50 time=118.809 ms
64 bytes from 104.76.225.252: icmp_seq=1 ttl=50 time=242.459 ms
64 bytes from 104.76.225.252: icmp_seq=2 ttl=50 time=112.145 ms
64 bytes from 104.76.225.252: icmp_seq=3 ttl=50 time=114.994 ms
Copy the highlighted IP address in the response.
Example IP address
104.76.225.252
Update the Local Hosts File
MAC:
1) Open Terminal
2) Type “sudo nano /private/etc/hosts” and then press Enter.
[image: ]
If prompted, enter your administrator password.
3) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
4) Save the file (Ctrl-o) and close Terminal (Ctrl-x).
Windows:
Launch Notepad as administrator by typing “Notepad” into the Windows search bar, right-clicking Notepad in the search results, and then clicking Run as administrator.
[image: ]
If prompted, click Yes in the User Account Control window.
5) In Notepad, click File and then click Open.
6) Navigate to C:\\Windows\System32\drivers\etc and then, to the right of the File name field, choose All Files (*.*) from the menu.
[image: ]
7) Open the hosts file.
8) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
[image: ]
9) In the File menu, click Save.
Connect to *concursolutions.com from the Local Machine
After configuring your local hosts file to direct connections to *concursolutions.com to the akamai staging environment, connect to *concursolutions.com from the local machine through the method you need to test. 
Your system administrator might need to test connections to *concursolutions.com made via an API call, connected application, or by navigating to the sign-in page through a web browser and signing in as an SAP Concur user.
Configuration / Feature Activation
To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, any applications that use an unsupported cipher must be updated to use a supported cipher.
If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
[bookmark: _Toc109306783]Test Entities | Production Sandbox Environment
[bookmark: _Toc109306784]**Ongoing** Most Recently Used Lists Not Migrated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306785]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Due to the architectural changes that SAP Concur must make to support this move, when PSEs are migrated to the new environment, some Most Recently Used (MRU) list items within the PSE will not be migrated.
MRU lists consist of recent selections made by the user. These lists are generated overtime as users interact with various menus and other defined lists and they will be regenerated after the PSE is migrated to the new environment.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs benefit from the same stability, monitoring capabilities, and level of performance as production entities.
End-User Experience
After the migration, some MRU lists that were generated prior to the migration will be empty. These lists will be regenerated automatically through the normal use of the PSE.
The following screenshots show some examples of MRU lists that will be impacted by the migration:
Create New Expense in Concur Expense
[image: ]
New Segment in Concur Request
[image: ]
Configuration / Feature Activation
This change occurs when a PSE is migrated to the new AWS environment; there are no configuration or activation steps. The MRU lists will be regenerated with normal user of the entity.
[bookmark: _Toc109306786]**Ongoing** Production Sandbox Environment Login Updates

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306787]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Today, a user can maintain the same login ID for their test and production entities because they are in separate environments. With the plan to migrate both test and production entities to the same AWS production environment in the future, this will no longer be possible since each login ID must be unique. 
While there is no action required for clients regarding this update, we want to ensure clients are aware of it because the change will be visible in certain areas of PSEs. To account for this change, SAP Concur will append all PSE login IDs with a ".uat” domain during both migration and user creation to ensure they are unique and do not conflict with any existing production login ID. For example, johnsmith@123.com will become johnsmith@123.com.uat.
IMPORTANT: No changes will made to the login IDs in the current implementation environment in our private data centers.

This process will occur in the background during both the migration and user creation processes. Because SAP Concur will manage this process, users will NOT have to make any changes to their login ID. 

Migrated users will still use the same implementation URL and login ID they used prior to the AWS migration. 

New clients will use the production URL with the appended login ID, which will include the appended domain (for example, johnsmith@123.com.uat). 
This change will help to safeguard against any conflicts with production login IDs. 
User Creation: Additionally, clients can use the exact same employee import files as they would in production. The uat domain will also be applied to all aspects of user creation: FTP import, Excel import, entity restore, and more.
Extracts: When generating accounting extracts or financial integration documents, SAP Concur will automatically remove the uat domain from login IDs that were appended during user creation. This will help to generate realistic extracts without requiring any actions from the clients, such as removing the appended domain.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc109306788]**Ongoing** Unique Address Required for PSE Email Verification

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2021
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306789]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
When PSEs are migrated to the AWS production environment, verified emails from the existing PSE will not carry over to the new PSE. As a result, when users test verified email functionality in a future PSE, it is recommended that the employee uses an email that is different from the email configured in their production entity. This process is required as the email in the existing PSE was most likely already verified in production and, therefore, cannot be verified in another entity.
With respect to user email addresses, the Receipt Recognition service validates user email addresses and as such, only one instance of an email address can be associated with a user account. To test in production, clients will be required to utilize alternate email addresses that are not currently associated with any production user account. If a client attempts to set up a test account in production using an email address already associated with a corresponding user profile, it will fail the validation process.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Admin Experience
BEFORE – Existing Email in Existing PSE
[image: Before screenshot of Existing Email in Existing Test Entity]
AFTER – New Email in New/Future PSE
[image: After screenshot of New Email in New/Future Test Entity]
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc109306790]User Assistance
[bookmark: _Toc109306791]Support for SAP Enable Now

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	July 8, 2022
	July 6, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306792]Travel, Expense, Invoice, Request | Professional & Standard
Overview
On July 6, SAP added support for SAP Enable Now with SAP Concur solutions. 
Business Purpose / Client Benefit
This change enables clients to use SAP Enable Now to create user assistance content to improve user adoption and increase efficiency with SAP Concur solutions.
End-User Experience
When SAP Enable Now is enabled, end users who have permission to view the content see Explore Interactive Walkthroughs in the Get Assistance section of the Help menu.
[image: ]
The interactive walkthroughs give end users access to guided assistance.
[image: ]
Admin Experience
For clients with SAP Enable Now, the client admin can provide access to SAP Enable Now user assistance for Concur for users based on the country/region assigned to the user in their user account.
Professional Edition
[bookmark: _Hlk107926332]SAP Enable Now user assistance for Concur is enabled based on the Country of Residence assigned to a user in the Expense Settings section of their user account.
[image: ]
For more information on user administration, refer to the Shared: User Administration Guide.
Standard Edition
[bookmark: _Hlk107926427]SAP Enable Now user assistance for Concur is enabled based on the Country/Region of Residence assigned to a user in the User Information section of their user account.
[image: ]
To enable and disable SAP Enable Now User Assistance for Concur based on country/region
1. Confirm the country/region assigned to the users for whom you want to enable User Assistance for End Users.
Professional Edition
[image: ]
Standard Edition
[image: ]
Confirm the Turn On User Assistance switch is toggled to the On position.
Be default, all eligible country/regions are checked when SAP Enable Now user assistance for Concur is first enabled.
[image: ]
3. (Optional) Deselect (uncheck) Select All to uncheck all country/regions in the list.
[image: ]
Confirm the desired county/region is enabled (checked) in the list of countries/regions. If the desired country/region is disabled (unchecked), enable the country/region.
[image: ]
For more information about user administration, refer to Shared: Users Setup Guide for Concur Standard Edition.
Configuration / Feature Activation
[bookmark: _Hlk107926668]Clients who have SAP Enable Now and who want to enable it for their SAP Concur solutions can contact SAP Concur support to enable SAP Enable Now. When the client contacts SAP Concur support, they must provide their SAP Enable now Init script URL.
After SAP Enable Now has been enabled, the client admin can enable and disable SAP Enable Now user assistance for Concur on the SAP Concur User Assistance page based on the country assigned to the user in their user profile.
[bookmark: _Toc109306793]User Import and Export
[bookmark: _Toc109306794]User Export and Import Improvements

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 22, 2022
	July 21, 2022
	August 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306795]Expense, Invoice, Request | Standard Edition
Overview
In August, SAP Concur plans to implement improvements to the user export/import experience.
Beginning on July 21, when an admin navigates to the Users page in Product Settings, they have the option to try out the improvements through a banner that is available at the top of the page.
Improvements include, but are not limited to:
· Improvements to the downloadable user data template including tooltips and drop-down lists
· Removal of the 1000 user maximum for imports and exports of user data
· The addition of a new Manage Users via a Spreadsheet page

Business Purpose / Client Benefit
These improvements increase the ease of use and experience of the user import and export processes.
Admin Experience
On the Users page in Product Settings, a banner with the following message is available at the top of the page:
"Click here to try out the new Manage User via a Spreadsheet experience, and provide your early feedback."
[image: ]
The admin can click the word "here" to opt-in to the experience.
[image: ]
After they click here, the banner message text changes to the following:
"Welcome to the new Manage User via a Spreadsheet experience. In addition to the new UI, we have also updated the spreadsheet template to include user-friendly header rows, drop-down menus, and tooltips for your reference. Click here to provide your feedback on the new experience. If you like, you can change back to the existing experience."
[image: ]
In the new message, the admin can click the word "here" to provide feedback on the experience through a brief survey.
The admin can also click the phrase "change back to the existing experience" to opt out of the new spreadsheet experience.
After opting in to the experience, on the Users page in Product Settings, when the admin clicks Add Users > From Spreadsheet, the admin sees the new Manage Users via a Spreadsheet page.
[image: ]
On the Manage Users via a Spreadsheet page, the admin can export, update, and import user data.
[image: ]
When they export the spreadsheet, they will see new tooltips and, where applicable, drop-down lists in the spreadsheet. In addition, they will no longer be limited to downloading 1000 rows of user data.
Tooltip Example
Tooltips appear when you hover over a column header in the spreadsheet.
[image: ]
Drop-down List Example
Drop-down lists are available for columns where applicable.
[image: ]
Configuration / Feature Activation
After the opt-in period has ended, the new user export/import experience will be automatically available.
[bookmark: _Toc109306796]Planned Changes
[bookmark: _Hlk92890624]The following features and changes are targeted for future releases. SAP Concur solutions reserves the right to postpone implementation of – or completely remove – any enhancement/change mentioned here. 
[bookmark: _Toc46229145][bookmark: _Hlk523311325][bookmark: _Toc478727899][bookmark: _Toc109306797]Fax Feature
[bookmark: _Toc109306798]**Planned Changes** Fax Feature to be Decommissioned

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 2021
	January 14, 2022
	October 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306799]Expense, Invoice | Professional & Standard
Overview
On October 1, 2022, the Concur Fax Feature will be decommissioned.
[bookmark: _Hlk86919337]The Fax feature was retired in 2020. Clients onboarded after July 15, 2020 do not have access to this feature. Among clients with access, very few use the feature regularly and, among those that use it, use has declined steadily.
Business Purpose / Client Benefit
Removal of the Fax feature improves the security, performance, and scalability of SAP Concur solutions. 
In addition, The Concur Fax Feature attaches files only at the header level of expenses and invoices. As a result, clients who use the Fax Feature cannot take advantage of recent innovations that apply only to images and attachments at the line-item level.
End-User Experience
Users will no longer have the option to print Fax cover pages from within Concur Expense or Concur Invoice and they will no longer have the ability to fax images to SAP Concur for attachment to expenses or invoices.
Configuration / Feature Activation
This change occurs automatically; there are no configuration steps. Additional information about this change will be made available over the coming months.
[bookmark: _Toc79737887][bookmark: _Toc109306800]File Transfer Updates
[bookmark: _Toc109306801]**Planned Changes** New File Transfer Endpoints After Migration to AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 10, 2022
	June 17, 2022
	Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306802]All Products | Professional & Standard
Overview
With the SAP Concur migration to Cloud Platform in AWS, new endpoints will be implemented for file transfers. After your entity is migrated to the new platform, you will receive notification about the migration including the new endpoints. After you receive notification, you will have 30 days to switch from the old endpoint(s) to the new AWS Transfer endpoint(s).
IMPORTANT! Do not switch endpoints until you have been notified. Doing so will have unpredictable results.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
Business Purpose / Client Benefit
The SAP Concur migration to Cloud Platform in AWS provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Configuration / Feature Activation
After you receive notification that your entity has been migrated to AWS, you will have 30 days to update your systems to point to the new AWS Transfer endpoints.
IMPORTANT! Do not switch endpoints until you have been notified. Doing so will have unpredictable results.
[bookmark: _Toc109306803]User Administration
[bookmark: _Toc109306804]**Planned Changes** Standalone White Spaces No Longer Valid in User Account Name Fields

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 17, 2022
	--
	Phased beginning in July

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306805]Travel, Expense, Invoice, Request | Professional & Standard
Overview
SAP Concur plans to apply validation that prevents the use of standalone white space characters in name fields in user accounts. This validation will be implemented in phases, beginning in mid-to-late July 2022.
Planned changes include the following:
· Standalone white space characters will no longer be accepted as a valid entry in name fields in user accounts.
White space characters that are part of a valid name will be accepted.
· If a name field is populated with only white space characters via the API, the employee import file, or manual entry, a message or error will be returned and the entries will not be accepted. 
The type of response received when entering an invalid name depends on the method of entry.
Business Purpose / Client Benefit
Ensuring that valid names are entered into the name fields in SAP Concur solutions can prevent errors when the data is exported to external systems that do not support or cannot process standalone white space characters in name fields.
Admin Experience
If an admin attempts to enter only white spaces in a name field on the User Details page, through an API call, or through the employee import process, the entry or entries will not be accepted and a message or error will be returned.
White space characters that are part of a valid name—for example, "Mary Ann"—are valid and will continue to be accepted. 
Configuration / Feature Activation
This validation will be added automatically.
[bookmark: _Toc109306806]User Assistance
[bookmark: _Toc109306807]**Planned Changes** Concur User Assistance by WalkMe to be Enabled

	Information First Published
	Information Last Modified
	Feature Target Release Date

	July 15, 2022
	--
	October 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc109306808]All Products | All Editions
Overview
On October 1, 2022, SAP Concur plans to enable Concur User Assistance by WalkMe on client sites with Concur Expense and/or Concur Invoice. User Assistance by WalkMe helps administrators and end users complete tasks by providing guided help while they are using SAP Concur solutions.
This change does not impact the following clients:
- Clients with Concur Travel only
- Clients with SAP Enable Now for Concur
Business Purpose / Client Benefit
This feature helps users learn new tasks more quickly and efficiently, driving user adoption, increasing efficiency, improving the user experience, and improving user satisfaction with SAP Concur solutions.
Admin Experience
User Assistance Settings Page
After User Assistance by WalkMe is enabled for all clients on October 1, 2022, the administrator will be able to access the User Assistance Settings Page to enable and disable User Assistance by WalkMe for their end users.
Professional Edition
After the feature is enabled by SAP Concur internal staff, a client admin with the Company Administrator role can access the User Assistance Settings page from the Company Administration page.
[image: ]
For more information about roles, refer to the Shared: User Administration Guide.
Standard Edition
After the feature is enabled by SAP Concur internal staff, a client admin with the Can Administer permission can access the User Assistance Settings page from the Administration > Company > Tools page. 
[image: ]
For more information about Concur Standard Edition permissions, refer to the Shared: Users Setup Guide for Concur Standard Edition.
Enabling/Disabling User Assistance for End Users
On the User Assistance Settings page, the administrator can enable and disable user assistance for end users globally. They can also enable and disable user assistance for end users based on a user’s assigned country or region. 
When the administrator selects a country/region on the User Assistance Settings page, the feature is enabled for all end users assigned to that country/region. 
[image: ]
Enabling or disabling user assistance for end users does not impact user assistance for admins. User assistance for admins is enabled and disabled by SAP Concur internal staff. 
End-User Experience
After the feature is enabled on October 1, 2022, User Assistance by WalkMe content can be accessed through the SAP Concur Help menu by clicking Explore Interactive Help. 
[image: ]
The list of items in the Help menu depends on a user's roles and permissions and on the configuration of the client's site. For example, only users with administrator privileges have access to Administrative Resources.
When the user clicks Explore Interactive Walkthroughs, the Get Assistance panel opens. The Get Assistance panel provides access to a list of resources including guided tours, video tutorials, and documents such as user guides.
[image: ]
The guided tours that are available in the Get Assistance panel are relevant to the page the user is on. For example, when the user is on the Manage Expenses page, the guided tours in the Get Assistance panel reflect tasks that can be performed on that page, such as creating an expense report and viewing expense details.
[image: ]
If a user clicks on a guided tour, they are guided through the selected task by a series of messages.
Example Guided Tour: Create an Expense Report 
[image: ]
[image: ]
[image: ]
Configuration / Feature Activation
SAP plans to enable User Assistance by WalkMe on October 1, 2022. After the feature is enabled on October 1, 2022, clients who do not wish to have User Assistance by WalkMe enabled can open an SAP Concur support ticket to disable the feature.
This change does not impact the following clients:
- Clients with Concur Travel only
- Clients with SAP Enable Now for Concur
[bookmark: _Toc510082427][bookmark: _Toc12880017][bookmark: _Toc46229154][bookmark: _Toc11147478][bookmark: _Toc109306809]Client Notifications
[bookmark: _Toc69211924][bookmark: _Toc480899347][bookmark: _Toc483562026][bookmark: _Toc484092107][bookmark: _Toc480899345][bookmark: _Toc483562024][bookmark: _Toc484092109][bookmark: _Toc510082430][bookmark: _Toc514338227][bookmark: _Toc12880020][bookmark: _Toc46229157][bookmark: _Toc109306810]Accessibility
[bookmark: _Toc69211925][bookmark: _Toc109306811]Accessibility Enhancements
SAP implements changes to better meet current Web Content Accessibility Guidelines (WCAG). Information about accessibility-related changes made to SAP Concur solutions is published on a quarterly basis. You can review the quarterly updates on the Accessibility Updates (English Only) page.
[bookmark: _Toc109306812]Subprocessors
[bookmark: _Toc480899346][bookmark: _Toc483562025][bookmark: _Toc484092110][bookmark: _Toc510082431][bookmark: _Toc514338228][bookmark: _Toc69118207][bookmark: _Toc109306813]SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors / Data Transfer Factsheets page.

To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
Sign in to the SAP Support Portal using your Support User ID (S-user) and password.
SAP customers must sign in to the SAP Support Portal using their Support User ID (S-user) and password. For information about S-User IDs, refer to Your New Support User ID (S-user). 
On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in the Search field.
In the Title column, click SAP Concur Sub-processors List.
If you have questions or comments, please reach out to: Privacy-Request@Concur.com 

[bookmark: _Toc77840903][bookmark: _Toc109306814]Supported Browsers
[bookmark: _Toc77840904][bookmark: _Toc109306815]Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will also appear in the Shared Planned Changes release notes.
[bookmark: _Toc90037239][bookmark: _Toc109306816]Additional Release Notes and Other Technical Documentation
[bookmark: _Toc90037240][bookmark: _Toc109306817]Online Help
Any user can access release notes, setup guides, user guides, admin summaries, monthly browser certifications, supported configurations, and other resources via online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product (Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP Help Portal (https://help.sap.com) to view the full set of documentation for your product.
[bookmark: _Toc90037241][bookmark: _Toc109306818][bookmark: _Toc530557893]SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu. Click to access the SAP Concur support portal, then click Resources. 
Click Release/Tech Info for release notes, technical documents, etc. 
Click Webinars for recorded and live webinars.
[image: P1891#yIS1]
© 2022 SAP SE or an SAP affiliate company. All rights reserved.
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Table 6: Data for record ID "TravelAddendumImport”

1 Transaction Type 350 Y. This is a static numeric value always equal to 350. It indicates the Record Type
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3 Name Prefix 60 characters maximum N Must contain these exact values (Lord, Lady, Sir, Mr, Miss, Ms, Mrs, Dr, Rev, Prof)
4 Name Suffix 60 characters maximum N Must contain these exact values (Jr., Sr., I, II, III, IV, V, VI)

5 Nick Name 60 characters maximum N Informal, non-birth name employee is known as.
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# Additionally, comments (such as these) may be inserted on individual
#lines or following the machine name denoted by a # symbol.

#

# For example:

#

# 102549497  rhino.acme.com # source server

# 38256310 xacme.com #x client host

# localhost name resolution is handled within DNS itself.
# 127001 localhost
# A localhost

104.76.225 252 www concursolutions.com
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